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SPRACHE IN Paragraph-Style “05 - STANDARD Fließtext” passend einstellen

1 ¡Bienvenido al mundo de GUITAR RIG 4!
GUITAR RIG KONTROL EDITION es la solución ideal para guitarristas y bajistas. El pedal 
RIG KONTROL se acopla perfectamente con el programa GUITAR RIG 4 y proporciona una 
calidad de sonido superior con su interfaz de audio integrada. Diseñado y optimizado para 
su uso con GUITAR RIG 4, cumple con todos los estándares de la industria, ofrece un total 
soporte MIDI y puede usarse perfectamente con la mayoría de los programas profesionales 
de audio. 

El RIG KONTROL se conecta al ordenador mediante una conexión USB 2.0 de alta velocidad, 
a través de la cual recibe también su alimentación eléctrica. Cuenta con dos entradas aptas 
tanto para conectar instrumentos como dispositivos que generan señales de línea. Una línea 
de salida de dos canales permite la conexión del aparato a su sistema de altavoces y un en-
chufe estéreo permite la conexión de los auriculares con manejo de volumen independiente.

Como controlador, RIG KONTROL ofrece 9 interruptores y un pedal permitiéndole un control 
casi total de todas las funciones de GUITAR RIG 4 . Además, presenta conexiones MIDI y 
dos entradas análogas para su conexión a controladores externos.

En los capítulos siguientes describiremos las características del RIG KONTROL y su mejor 
modo de empleo. Por favor, lea esta manual cuidadosamente para poder familiarizarse con 
el producto.
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2 Antes de empezar: Observaciones importantes
Antes que nada, lea primero este capítulo cuidadosamente antes de emplear su GUITAR RIG 4.

2.1 Números de serie y chapa identificadora

GUITAR RIG KONTROL EDITION viene con dos números de serie. En la parte inferior del 
producto encontrará el número de serie del RIG KONTROL y la chapa identificadora con el 
nombre del modelo y otras especificaciones técnicas. El número de serie necesario para la 
activación del programa GUITAR RIG 4 está situado en funda del CD del producto.

2.2 Usar la unidad de manera segura

Lea estas instrucciones atentamente para evitar daños a su salud o al producto.

2.2.1 Advertencia
Para prevenir lesiones auditivas, observe las siguientes recomendaciones de seguridad:

 • Este producto combinado con un amplificador, auriculares o altavoces puede generar so-
nidos de volumen muy alto perjudiciales para el oído.

 • Para su protección, baje el volumen de todos los dispositivos antes de ponerse a usar el 
RIG KONTROL. Al tocar la música, suba el volumen gradualmente hasta alcanzar el nivel 
deseado.

 • No lo utilice durante tiempos prolongados a volúmenes elevados. Si experimenta problemas 
auditivos o zumbidos en los oídos, consulte inmediatamente al médico.
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2.2.2 Precauciones
Para asegurar que el RIG KONTROL o cualquier dispositivo conectado al mismo no resulte 
dañado durante su uso o mantenimiento, es importantes que siga las siguientes instrucciones:

 • No abra el dispositivo ni intente desarmarlo o modificar su interior. El dispositivo tiene com-
ponentes que no pueden ser reparados por el usuario. Si el aparato no funcionara correc-
tamente, suspenda inmediatamente su uso y hágalo revisar por personal calificado.

 • No exponga el aparato a la lluvia y no lo utilice cerca del agua o en condiciones de hume-
dad.

 • Evite la penetración de cualquier objeto o líquido en la unidad.

 • Nunca use o guarde la unidad en lugares sujetos a temperaturas extremas (p. ej., bajo la 
luz directa del sol en un automóvil o cerca de la calefacción) o a altos niveles de vibración. 

 • No coloque el RIG KONTROL en una posición inestable en la que pueda caer al piso acci-
dentalmente. Antes de mover la unidad, desenchufe los cables conectados.

 • Antes de encender o apagar algún componente, ponga a mínimo el volumen del mismo. 

 • No emplee excesiva fuerza al usar las perillas o los conectores.

 • Para la limpieza del RIG KONTROL use un paño suave y seco. No emplee solventes, líqui-
dos limpiadores o paños con químicos limpiadores.

2.2.3 Deposición del producto
Si por alguna causa el producto se estropeara sin posibilidad de arreglo o si llegara al término 
de su vida útil, cumpla con las regulaciones de su país relativas a la deposición de residuos 
electrónicos.
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2.3 Descargo de responsabilidad

Native Instruments GmbH no puede responsabilizarse por daño al aparato o pérdida de datos 
causados por uso indebido o por modificaciones realizadas al RIG KONTROL.

La información contenida en este manual es la correcta al momento de su impresión o apari-
ción digital. Sin embargo, Native Instruments se reserva el derecho de realizar modificaciones 
a las especificaciones existentes, en cualquier momento, y sin previo aviso ni obligación de 
actualizar las unidades existentes.
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3 El hardware del RIG KONTROL
Este capítulo le brindará un panorama general de la mecánica del RIG KONTROL.

3.1 Panel superior

1 Los interruptores de pie pueden asignarse en el programa para realizar tareas como el 
recorrido de presetes o el apagado/encendido de componentes individuales. Cada inte-
rruptor cuenta con un LED que indica si el mismo se encuentra o no activado. La fila 
superior de interruptores está identificada con el nombre de las funciones más frecuentes 
de GUITAR RIG 4 y ejecuta las correspondientes funciones preconfiguradas.

2 El pedal de expresión puede usarse para controlar cualquier parámetro continuo del 
software, tal como el volumen o el wah-wah. Bajo la punta del pedal hay un interruptor 
libremente asignable. 

3 Muestra el número del preset de GUITAR RIG 4 activado. 
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4 Este LED es un medidor que muestra el volumen de entrada de la señal de audio. Cuando 
está rojo, indica la presencia de distorsión. Si lo hace baje entonces la ganancia de  
entrada.

5 Este LED es un medidor que muestra el volumen de salida de la señal de audio. Cuando 
está rojo, indica la presencia de distorsión. Si lo hace baje entonces el volumen de salida.

6 Este LED indica que el RIG KONTROL está recibiendo señales MIDI provenientes de un 
secuenciador u otro tipo de controlador.

7 Este LED muestra si el interruptor bajo el pedal se encuentra o no activado.

3.2 Panel posterior

1 El interruptor Inst/Line establece la sensibilidad de entrada para las entradas 1 y 2. 
Cuando no está presionado, las entradas aceptan señales provenientes de instrumentos 
como guitarras o bajos; cuando está presionado, aceptan señales de línea. El tipo de 
entrada seleccionado se indica en la parte de arriba de la unidad.

2 Esta perilla controla la ganancia de la entrada 1.

3 El enchufe de Input 1 (conector de ¼”, TRS balanceado) acepta la entrada de señales 
de línea o de instrumento, dependiendo de como esté puesto el interruptor Line/Inst. 
Conecte aquí su guitarra, bajo o teclado, o el canal izquierdo de un dispositivo estéreo.

4 El enchufe de Input 2 (conector de ¼”, TRS balanceado) acepta la entrada de señales de 
línea o de instrumento, dependiendo de como esté puesto el interruptor Line/Inst. Conecte 
aquí una segunda guitarra, bajo o teclado, o el canal derecho de un dispositivo estéreo.
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5 Esta perilla controla la ganancia de la entrada (Input) 2.

6 Esta conexiones transmiten la salida de la interfaz de audio. Conecte ambas si desea un 
sonido estéreo. 

7 La amplificación de la salida puede ser máxima o de -14 dB.

8 Control de volumen independiente para la salida de auriculares.

9 Enchufe para la conexión de auriculares estéreo.

10 Enchufe para la conexión de pedales de expresión externos, interruptores de pie, pedales 
de volumen o cajas interruptoras.

11 El RIG KONTROL cuenta también con una interfaz MIDI con una (1) entrada y una (1) 
salida. El RIG KONTROL no necesita MIDI para enviar mensajes de controlador a GUITAR 
RIG 4, pero es capaz de enviar señales MIDI a otras aplicaciones.

12 El puerto USB conecta la unidad con el ordenador. Su ordenador debe admitir la conexión 
USB 2.0 para poder trabajar con el RIG KONTROL. La unidad también se alimenta de la 
energía eléctrica transmitida a través del puerto USB. Conecte la unidad directamente en 
el puerto USB 2.0 del ordenador y evite el empleo de concentradores (hubs) sin fuente 
de alimentación propia. Como seguridad, debería siempre enganchar el cable USB en el 
gancho.
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4 Instalación en Windows XP / Windows Vista
Este capítulo describe la instalación básica del RIG KONTROL en Windows XP y en Windows 
Vista, especialmente la instalación de la interfaz de audio. Para activar el pedal en GUITAR 
RIG 4 y emplear su capacidad MIDI, consulte el capítulo 6 de este manual.

Para más información sobre el programa GUITAR RIG 4, consulte el manual de dicha aplica-
ción. El mismo se encuentra en el CD del producto o en el menú de GUITAR RIG 4 bajo la 
opción Help > Open Manual > Your Language.

4.1 Instalación del programa 

Asegúrese de haber iniciado la sesión con privilegios de administrador. No conecte todavía 
el RIG KONTROL.

1. Revise el contenido del CD para ubicar el archivo de instalación. El mismo se llama “Guitar 
Rig 4 Setup”. Si está empleando una versión descargada de GUITAR RIG 4, deberá pri-
mero extraer el archivo de instalación.

2. Haga doble clic sobre el archivo denominado “Guitar Rig 4 Setup” para iniciar el proceso 
de instalación.
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3. Siga las instrucciones en pantalla que lo guiarán a través del proceso de instalación.

4. Se le pedirá determinar la ruta a la carpeta del plugin de su EAD (estación de audio 
digital; p.ej., su programa secuenciador). Si desea usar GUITAR RIG 4 exclusivamente 
en el modo standalone (independiente) o si no sabe bien lo que es un plugin, utilice 
simplemente la opción estándar.

5. Se le preguntará si desea instalar los controladores para las interfaces de audio de GUITAR 
RIG. Seleccione, “RIG KONTROL” y haga clic en “Continue”.

6. Durante la instalación, Windows mostrará varios mensajes de seguridad, p. ej.: “El contro-
lador no ha pasado el logotipo de Windows” o “Windows no puede verificar el proveedor 
de este controlador de programa”. No se preocupe, todo está bien. Simplemente, haga 
clic en “Continuar de todos modos” (Windows XP) o en “Instalar de todos modos el soft-
ware de controlador” (Windows Vista) y prosiga con la instalación.
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7. Completada la instalación, reinicie el ordenador.

Las siguientes aplicaciones han sido instaladas en el ordenador:

 • GUITAR RIG 4: la aplicación standalone con todas sus características.

 • GUITAR RIG 4 plugins: una versión plugin de GUITAR RIG 4 que podrá integrar a su esta-
ción de audio digital (EAD). En ordenadores con Windows, GUITAR RIG 4 acepta los for-
matos de plugin VST y RTAS®.

 • Native Instruments Service Center: esta aplicación se encarga de la activación del produc-
to y gestiona las actualizaciones del mismo. Consulte la guía “Setup Guide” para más infor-
mación.

 • Los controladores del RIG KONTROL.

Si solamente desea instalar los controladores del aparato, en el CD de instalación hallará por 
separado el correspondiente archivo de instalación del controlador. También podrá descargar 
la última versión del mismo en la sección de asistencia (Support) del sitio de Internet de 
Native Instruments.
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4.2 Instalación del aparato

Utilice el cable USB suministrado con el producto para conectar el RIG KONTROL directa-
mente a un puerto USB 2.0 del ordenador.

El RIG KONTROL se alimenta a través de la conexión USB. Su operación sólo puede garan-
tizarse si se lo emplea como dispositivo único de un controlador USB 2.0 o con un hub USB 
2.0 con fuente de alimentación propia. En Windows XP, solamente funciona a partir de la 
versión Service Pack 2; podrá averiguar la versión de su sistema operativo en la ventana de 
propiedades del sistema. 
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Tras la correcta instalación del controlador, el RIG KONTROL será reconocido automáticamen-
te. Si esto no llegara a ocurrir, inicie nuevamente la instalación del programa de la manera 
ya descrita.

Ahora, los módulos del controlador serán asignados al RIG KONTROL y cada uno de ellos 
abrirá una ventana para preguntarle de que manera desea instalar el nuevo dispositivo.

1. Seleccione “no conectar con el sitio web Windows Update”.

2. Seleccione “Instalar el programa automáticamente” (Windows XP) o “Localizar e instalar 
el controlador del programa” (Windows Vista).
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3. Siga las instrucciones de pantalla hasta completar el procedimiento.

4. Los avisos de seguridad de Windows comenzarán a aparecer. Ignórelos y haga clic en la 
opción “Continuar de todos modos” (Windows XP) o “Instalar el software de controlador 
(Windows Vista) para que los controladores se instalen correctamente.

En un ordenador con Windows, el controlador está asociado a un puerto USB en particular. 
Si enchufa el cable USB en un puerto diferente del puerto de instalación original, el proceso 
de asignación del controlador podría comenzar nuevamente: si esto sucediera, simplemente 
siga los pasos explicados más arriba..

Si en algún momento, el ordenador parece no reconocer el RIG KONTROL, desconecte el 
cable USB, espere unos segundos y vuelva a conectarlo. Si el problema continua, reinicie el 
ordenador teniendo la interfaz conectada.
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4.3 Configuración

Este capítulo describe el empleo de la interfaz de audio RIG KONTROL en Windows XP/
Windows Vista, atendiendo especialmente su uso conjunto con GUITAR RIG 4. Vamos a su-
poner que usted ya ha activado su GUITAR RIG 4 a través del Centro de Servicio, (consulte 
la guía “Setup Guide” para más información).

4.3.1 Configurar GUITAR RIG 4
Ahora vamos a configurar GUITAR RIG 4 para su uso con la interfaz de audio RIG KONTROL. 
Primero, inicie el programa.

Cuando el programa arranque por primera vez, la ventana de configuración de audio “Audio 
Setup” aparecerá automáticamente para que pueda llevar a cabo las configuraciones co-
rrespondientes. Para abrir esta ventana en un momento posterior, en la barra de menú del 
programa seleccione File > Audio and MIDI Settings. 

   

1. Abra la ficha „Audio“ y en „Driver“ seleccione ASIO como la interfaz del controlador.
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2. Seleccione RIG KONTROL en el menú de dispositivos (“Device”).

Si RIG KONTROL no aparece en la lista, entonces algo salió mal. Vuelva a efectuar la insta-
lación de la manera explicada en el apartado 4.1.

Podrá acceder al panel de control del controlador al cliquear sobre el botón “ASIO Config”. 
El panel de control del controlador presenta abajo dos campos de lectura de estado que le 
indicarán si el RIG KONTROL está conectado y listo para ser utilizado.

   

La interfaz de audio permite la configuración de los siguientes parámetros:

 • Presets: se incluyen varios presetes destinados a los usos más frecuentes; desde presetes con 
latencia mínima para sistemas rápidos con mucha capacidad de procesamiento hasta presetes 
con latencias más altas, para sistemas más lentos. Si usted ya tiene experiencia en la configu-
ración de controladores de audio y desea crear su propio juego de configuraciones, seleccione 
entonces la opción “User Defined Settings” (ver abajo).
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 • USB Buffersize y Audio Buffersize: estos parámetros aparecen de color gris si la opción User 
Defined Settings no fue seleccionada en el el menú de Presets. Juntos, estos parámetros de-
finen el sistema de latencia, es decir, el tiempo que pasa desde el momento en que la señal 
de audio se envía al hardware de RIG KONTROL y el momento en que dicha señal es oída a 
través de los auriculares o altavoces. Tenga en cuenta que el valor de Audio Buffersize deberá 
ser por lo menos dos veces mayor que el valor de USB Buffersize. El tamaño del búfer del USB 
(USB Buffersize) incide directamente en el uso de CPU por parte del sistema. El consumo 
resultante de CPU difiere mucho de un ordenador a otro, por lo que es una buena idea ir pro-
bando distintas configuraciones.

 • Sample Rate: seleccione una frecuencia de muestreo que sea compatible con su programa de 
música y con la capacidad de cálculo del ordenador. Por defecto, la frecuencia de muestreo 
está puesta en 44100 Hz (calidad de CD). Frecuencias más altas pueden mejorar la calidad 
del sonido pero exigirán, a su vez, una capacidad de procesamiento mayor.

Recomendamos que pruebe primero los tres presetes de latencia que aparecen en primer término 
y luego continuar con los restantes pasos de la instalación. Cuando haya terminado, en algún 
momento posterior debería revisar nuevamente la ficha Audio and MIDI Settings y determinar 
cuál es la mejor latencia para su sistema. Si experimenta fallas en el audio con el preset minimal 
latency, pruebe las configuraciones low latency o standard latency. Valores de latencia más altos 
reducirán la probabilidad de sufrir problemas con el audio.

4.3.2 Emplear el RIG KONTROL como la interfaz de audio predeterminada
Si desea usar el RIG KONTROL para reproducir todas las aplicaciones de audio de su ordenador 
(y no sólo el software de música), deberá configurarlo para que sea la interfaz de audio prede-
terminada del sistema.

En Windows XP haga lo siguiente:

1. Abra Inicio > Panel de control > Sonidos y dispositivos de audio.

2. Seleccione la ficha “Audio”.

3. En “Reproducción de sonido” y en “Grabación de sonido”, haga clic en el menú de dis-
positivos predeterminados y seleccione RIG KONTROL.
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4. Haga clic en Aceptar para cerrar la ventana de Sonidos y dispositivos de audio.

 

En Windows Vista haga lo siguiente:

1. Abra Inicio > Panel de control > Hardware y sonido > Sonido.

2. Seleccione la ficha “Reproducción”.

3. En la lista de dispositivos, seleccione RIG KONTROL y luego haga clic en “Predeterminar”.

4. Seleccione la ficha “Grabar”.

5. En la lista de dispositivos, seleccione RIG KONTROL y luego haga clic en “Predeterminar”.

6. Haga clic en Aceptar para finalizar.
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4.4 Conexiones de audio y niveles

En los capítulos siguientes aprenderá la manera de conectar el RIG KONTROL a su guitarra y 
sistema de altavoces, y a establecer los niveles de amplificación correctos tanto en el aparato 
como en el programa.

Antes de continuar, inicie por favor la aplicación GUITAR RIG 4.

4.4.1 Conectar el instrumento y ajustar el volumen de entrada
1. Baje el volumen de su sistema de monitorización para evitar lesiones auditivas.

2. Asegúrese de que el selector de entradas esté puesto en “Instrument” (el botón no está 
oprimido), salvo si quiere emplear un preamplificador para reforzar la señal hasta el nivel 
de línea.

3. Enchufe el cable de su guitarra o bajo en una de las entradas del RIG KONTROL.

4. Baje completamente el volumen del canal de entrada que no está usando.

Tenga en cuenta que los instrumentos que generan señales estéreo, como por ejemplo los 
sintetizadores de teclado, deberán ser conectados a ambos canales de entrada para obtener 
sonido estereofónico.
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Para obtener la mejor calidad de sonido posible, deberá suministrarle a la interfaz una señal 
que sea lo suficientemente potente; por lo que debería ajustar cuidadosamente el volumen 
de entrada del RIG KONTROL.

El medidor de volumen de entrada le indicará el volumen de la señal entrante

Estado del medidor Significado

Los LED están apagados La señal no está presente.

Los LED verdes están encendidos Se está registrando el ingreso de la señal.

Los LED verdes y rojos están encendidos El volumen de la señal entrante es muy alto.

 

Antes de ajustar la sensibilidad de entrada, baje la perilla de volumen de su guitarra. Toque 
algunos acordes al volumen al que acostumbra tocar y eche un vistazo a los LED:

1. Mientras está tocando, suba la perilla del volumen de entrada junto al enchufe de entrada 
utilizado hasta que el medidor apenas alcance la zona roja.

2. Ahora, baje despacio la perilla hasta que el los LED dejen de emitir luz roja, aun al tocar 
acordes muy fuertes.

Ahora la sensibilidad de entrada está puesta en un nivel óptimo y el RIG KONTROL puede 
proporcionar un rango dinámico muy alto sin caer en distorsión.

4.4.2 Conectar un segundo instrumento
Es posible conectar un instrumento en cada canal siempre que los mismos suministren el 
mismo tipo de señal (línea o instrumento). Enchufe el cable de un segundo instrumento en 
la otra entrada y ajuste el nivel de volumen de la manera descrita en el apartado anterior.

% 
Si solamente emplea un canal, la perilla Gain del otro canal debe estar puesta en cero.



GUITAR RIG KONTROL – 25

Para instrumentos que generan una señal estéreo, es necesario utilizar también el segundo 
canal para lograr así un sonido estereofónico.

4.4.3 El volumen de entrada de GUITAR RIG 4
Vamos a dar por sentado que su guitarra ya está conectada al RIG KONTROL y que su nivel 
de entrada fue correctamente ajustado (véase el apartado 4.4.1). Ahora debemos asegurarnos 
de que la señal de entrada sea procesada por el programa con un adecuado nivel de volumen.

Eche un vistazo a la cabecera de GUITAR RIG 4: está compuesta por un módulo de entrada 
con selectores de canal (l/r), un supresor de ruido (Gate) sencillo, un módulo de salida con 
un limitador y, finalmente, la información del consumo de CPU.

Tenga en cuenta que el medidor de entrada mostrará la amplitud al tocar el instrumento. 
También hallará un deslizante de volumen que controla el nivel de entrada del software. 
Ajuste este control hasta conseguir el nivel más alto posible sin producir distorsión. Esto lo 
podrá comprobar con el medidor de volumen, que se acercará hasta la zona roja sin llegar 
realmente a alcanzarla.

Si solamente una guitarra se hallara conectada, GUITAR RIG 4 recibirá una señal mono. Usted 
puede también configurar el módulo de entrada para que direccione la señal de su guitarra 
a través de ambos canales. Por defecto, GUITAR RIG 4 está configurado para procesar am-
bos canales de entrada (l + r están activados), por lo que uno de los canales permanecerá, 
entonces, en silencio. Para cambiar esto desactive el canal que no esté usando: cliquee el 
botón correspondiente (l o r) a la izquierda del medidor de volumen para desactivar dicho 
canal y que solamente quede activo el canal de entrada en uso. Con esto dirigirá la señal 
monoaural hacia ambos canales.
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4.4.4 Conectar la salida
El RIG KONTROL proporciona dos salidas mono (L/R) que le servirán para la conexión de 
su sistema de monitorización, sea éste una mesa de mezclas, un par de altavoces activos o 
el sistema estéreo de su casa. Tenga en cuenta que para lograr un sonido estéreo, deberá 
conectar los dos altavoces. Un salida estéreo separada (TRS) permite la conexión de sus 
auriculares.

1. Conecte las salidas del aparato con la entrada de su sistema de amplificación, habiendo 
bajado previamente el volumen. 

2. Si está usando auriculares, conéctelos en el enchufe de salida y tenga la precaución de 
bajar el volumen antes de ponérselos.

3. Vaya al buscador de presetes y seleccione un preset con un clic.

4. Empiece a tocar y suba cuidadosamente el volumen del amplificador o el volumen del 
RIG KONTROL para sus sus auriculares hasta alcanzar el nivel deseado.

Ahora todo está listo, ¡ya puede empezar a tocar!
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5 Instalación en Mac OS X
Este capítulo describe la instalación básica del RIG KONTROL en Mac OS X, especialmente 
la instalación de la interfaz de audio. Para activar el pedal en GUITAR RIG 4 y emplear su 
capacidad MIDI, consulte el capítulo 6 de este manual.

Para más información sobre el programa GUITAR RIG 4, consulte el manual de dicha aplica-
ción. El mismo se encuentra en el CD del producto o en el menú de GUITAR RIG 4 bajo la 
opción Help > Open Manual > Your Language.

5.1 Instalación del programa 

Asegúrese de haber iniciado la sesión con privilegios de administrador. No conecte todavía 
el RIG KONTROL.

1. Revise el contenido del CD y ubique el archivo “Guitar Rig 4 Installer”. Si está empleando 
una versión descargada de GUITAR RIG 4, deberá primero extraer el archivo de instala-
ción.

2. Haga doble clic sobre el archivo de instalación para iniciar el proceso de instalación.
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3. Siga las instrucciones en pantalla que lo guiarán a través del proceso de instalación.

4. Se le preguntará si desea instalar los controladores para las interfaces de audio de GUITAR 
RIG. Seleccione, “RIG KONTROL” y haga clic en “Continue”.

5. Completada la instalación, reinicie el ordenador.

Las siguientes aplicaciones han sido instaladas en el ordenador:

 • GUITAR RIG 4: la aplicación standalone con todas sus características.

 • GUITAR RIG 4 plugins: una versión plugin de GUITAR RIG 4 que podrá integrar a su esta-
ción de audio digital (EAD). En ordenadores con Mac OS X, el programa acepta los forma-
tos VST, AU y RTAS®.

 • Native Instruments Service Center: esta aplicación se encarga de la activación del produc-
to y gestiona las actualizaciones del mismo. Consulte la guía “Setup Guide” para más infor-
mación.
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 • Los controladores de la interfaz de audio RIG KONTROL.

% 
Si es propietario por primera vez de un producto NATIVE INSTRUMENTS, deberá registrarse 
siguiendo las instrucciones ofrecidas en pantalla. Para más información sobre como crear 

una Cuenta de Usuario NI y sobre la activación de GUITAR RIG 4, consulte la Guía de inicio rápido 
del Centro de Servicio y el manual ubicados en la carpeta de instalación del Centro de Servicio.

Si solamente desea instalar los controladores del aparato, en el CD de instalación hallará por 
separado el correspondiente archivo de instalación del controlador. También podrá descargar 
la última versión del mismo en la sección de asistencia (Support) del sitio de Internet de 
Native Instruments.

5.2 Instalación del aparato

Utilice el cable USB suministrado con el producto para conectar el RIG KONTROL directa-
mente a un puerto USB 2.0 del ordenador.

El RIG KONTROL se alimenta a través de la conexión USB. Su operación sólo puede garan-
tizarse si se lo emplea como dispositivo único de un controlador USB 2.0 o con un hub USB 
2.0 con fuente de alimentación propia.
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Tras la correcta instalación del controlador, el RIG KONTROL será reconocido automáticamen-
te. Si en algún momento, el ordenador parece no reconocer el RIG KONTROL, desconecte el 
cable USB, espere unos segundos y vuelva a conectarlo. Si el problema continua, reinicie el 
ordenador teniendo la interfaz conectada.

5.3 Configuración

Este capítulo describe el empleo de la interfaz de audio RIG KONTROL en Mac OS X, aten-
diendo especialmente su uso conjunto con GUITAR RIG 4. Vamos a suponer que usted ya ha 
activado su GUITAR RIG 4 a través del Centro de Servicio, (consulte la guía “Setup Guide” 
para más información).

5.3.1 Configurar GUITAR RIG 4
Ahora vamos a configurar GUITAR RIG 4 para su uso con la interfaz de audio RIG KONTROL. 
Primero, inicie el programa.

1. Cuando el programa arranque por primera vez, la ventana de configuración de audio 
“Audio Setup” aparecerá automáticamente para que pueda llevar a cabo las configura-
ciones correspondientes. Para abrir esta ventana en un momento posterior, en la barra 
de menú del programa seleccione Guitar Rig 4 > Preferences.
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2. Abra la ficha „Audio“, y en „Driver“, seleccione CoreAudio como la interfaz del controlador.

3. Seleccione RIG KONTROL en el menú de dispositivos (“Device”).

Si RIG KONTROL no aparece en la lista, entonces algo salió mal. Vuelva a efectuar la insta-
lación de la manera explicada en el apartado 5.1.

La interfaz de audio permite la configuración de los siguientes parámetros:

 • Sample Rate: seleccione una frecuencia de muestreo que sea compatible con su programa 
de música y con la capacidad de cálculo del ordenador. Por defecto, la frecuencia de mues-
treo está puesta en 44100 Hz (calidad de CD). Frecuencias más altas pueden mejorar la 
calidad del sonido pero exigirán, a su vez, una capacidad de procesamiento mayor.

 • Latency: el deslizante de latencia permite establecer el tamaño del búfer de la interfaz de 
audio (medido en samples). Esto presenta dos efectos: cuanto mayor sea el tamaño del 
búfer, menor será la probabilidad de experimentar problemas en el audio cuando éste sea 
procesado en tiempo real. Por otra parte, el tamaño del búfer afecta directamente la laten-
cia general del sistema. Si incrementa el tamaño del búfer, el tiempo transcurrido entre la 
ejecución de una nota y el momento cuando ésta suena será mayor.
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Recomendamos empezar primero con el tamaño de búfer predeterminado y continuar con 
los restantes pasos de la instalación. Cuando haya terminado, en algún momento posterior 
debería revisar nuevamente la ficha Audio and MIDI Settings y determinar cuál es la mejor 
latencia para su sistema. Esto se logra moviendo paulatinamente el deslizante de Latency 
hacia la izquierda mientras se está tocando algo. Si empieza a percibir ruidos o fallas, arrastre 
lentamente el deslizante hacia la derecha hasta que los mismos cesen por completo.

5.3.2 Emplear el RIG KONTROL como la interfaz de audio predeterminada
Si desea usar el RIG KONTROL para reproducir todas las aplicaciones de audio de su orde-
nador (y no sólo el software de música), deberá configurarlo para que sea la interfaz de audio 
predeterminada del sistema. En Mac OS X haga lo siguiente:

1. Desde el menú de Apple, seleccione Preferencias del sistema:

2. En el panel que se abre, seleccione “Sonido”.

  

3. En la ficha de efectos de sonido seleccione la opción RIG KONTROL en el menú de 
“Reproducir alertas y efectos de sonido”.
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4. Cliquee la ficha de “Salida” y seleccione RIG KONTROL en la lista de “Seleccionar un 
dispositivo para la salida de sonidos”.

5. Haga clic en la ficha “Entrada” y seleccione RIG KONTROL en la lista de “Seleccionar 
un dispositivo para la entrada de sonidos”.

5.4   Conexiones de audio y niveles

En los capítulos siguientes aprenderá la manera de conectar el RIG KONTROL a su guitarra y 
sistema de altavoces, y a establecer los niveles de amplificación correctos tanto en el aparato 
como en el programa.

Antes de continuar, inicie GUITAR RIG 4.

5.4.1  Conectar el instrumento y ajustar el volumen de entrada
1. Baje el volumen de su sistema de monitorización para evitar lesiones auditivas.

2. Asegúrese de que el selector de entradas esté puesto en “Instrument” (el botón no está 
oprimido), salvo si quiere emplear un preamplificador para reforzar la señal hasta el nivel 
de línea.

3. Enchufe el cable de su guitarra o bajo en una de las entradas del RIG KONTROL.

4. Baje el volumen del canal de entrada que no está usando.

Tenga en cuenta que los instrumentos que generan señales estéreo, como por ejemplo los 
sintetizadores de teclado, deberán ser conectados a ambos canales de entrada para obtener 
sonido estereofónico.
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Para obtener la mejor calidad de sonido posible, deberá suministrarle a la interfaz una señal 
que sea lo suficientemente potente; por lo que debería ajustar cuidadosamente el volumen 
de entrada del RIG KONTROL.

El medidor de volumen de entrada le indicará el volumen de la señal entrante.

LED de estado Significado

Los LED están apagados La señal no está presente.

Los LED verdes están encendidos Se está registrando el ingreso de la señal.

Los LED verdes y rojos están encendidos El volumen de la señal entrante es muy alto.

Antes de ajustar la sensibilidad de entrada, baje la perilla de volumen de su guitarra. Toque 
algunos acordes al volumen al que acostumbra tocar y eche un vistazo a los LED:

1. Mientras está tocando, suba la perilla del volumen de entrada junto al enchufe de entrada 
utilizado hasta que el medidor apenas alcance la zona roja.

2. Ahora, baje despacio la perilla hasta que los LED dejen de emitir luz roja, aun al tocar 
acordes muy fuertes.
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Ahora la sensibilidad de entrada está puesta en un nivel óptimo y el RIG KONTROL puede 
proporcionar un rango dinámico muy alto sin caer en distorsión.

5.4.2 Conectar un segundo instrumento
Es posible conectar un instrumento en cada canal siempre que los mismos suministren el 
mismo tipo de señal (línea o instrumento). Enchufe el cable de un segundo instrumento en 
la otra entrada y ajuste el nivel de volumen de la manera descrita en el apartado anterior.

% 
Si solamente emplea un canal, la perilla Gain del otro canal debe estar puesta en cero.

Para instrumentos que generan una señal estéreo, es necesario utilizar también el segundo 
canal para lograr así un sonido estereofónico.

5.4.3 El volumen de entrada de GUITAR RIG 4
Vamos a dar por sentado que su guitarra ya está conectada al RIG KONTROL y que su nivel 
de entrada fue correctamente ajustado (véase el apartado 4.4.1). Ahora debemos asegurarnos 
de que la señal de entrada sea procesada por el programa a un nivel adecuado.

Eche un vistazo a la cabecera de GUITAR RIG 4: está compuesta por un módulo de entrada 
con selectores de canal (l/r), un supresor de ruido (Gate) sencillo, un módulo de salida con 
un limitador y, finalmente, la información del consumo de CPU.

Tenga en cuenta que el medidor de entrada mostrará la amplitud al tocar el instrumento. 
También hallará un deslizante de volumen que controla el nivel de entrada del software. 
Ajuste este control hasta conseguir el nivel más alto posible sin producir distorsión. Esto lo 
podrá comprobar con el medidor de volumen, que se acercará hasta la zona roja sin llegar 
realmente a alcanzarla.



GUITAR RIG KONTROL – 36

Si solamente una guitarra se hallara conectada, GUITAR RIG 4 recibirá una señal mono. Usted 
puede también configurar el módulo de entrada para que direccione la señal de su guitarra 
a través de ambos canales. Por defecto, GUITAR RIG 4 está configurado para procesar am-
bos canales de entrada (l + r están activados), por lo que uno de los canales permanecerá, 
entonces, en silencio. Para cambiar esto desactive el canal que no esté usando: cliquee el 
botón correspondiente (l o r) a la izquierda del medidor de volumen para desactivar dicho 
canal y que solamente quede activo el canal de entrada en uso. Con esto dirigirá la señal 
monoaural hacia ambos canales.

5.4.4 Conectar la salida
El RIG KONTROL proporciona dos salidas mono (L/R) que le servirán para la conexión de 
su sistema de monitorización, sea éste una mesa de mezclas, un par de altavoces activos o 
el sistema estéreo de su casa. Tenga en cuenta que para lograr un sonido estéreo, deberá 
conectar los dos altavoces. Un salida estéreo separada (TRS) permite la conexión de sus 
auriculares.

1. Conecte las salidas del aparato con la entrada de su sistema de amplificación, habiendo 
bajado previamente el volumen.
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2. Si está usando auriculares, conéctelos en el enchufe de auriculares y tenga la precaución 
de bajar el volumen antes de ponérselos.

3. Vaya al buscador de presetes y seleccione un preset con un clic. Empiece a tocar y suba 
cuidadosamente el volumen del amplificador o el volumen del RIG KONTROL para sus 
sus auriculares hasta alcanzar el nivel deseado.

Ahora todo está listo, ¡ya puede empezar a tocar!
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6 Emplear el RIG KONTROL como un controlador
El RIG KONTROL multiplica el desempeño de GUITAR RIG 4 al poder usarse como controla-
dor de otros dispositivos. Entre otras características, ofrece conexiones MIDI y dos enchufes 
para pedales e interruptores de pie externos. Las secciones siguientes describirán la manera 
de configurar el aparato para aprovechar al máximo todas estas características. Para saber 
como asignar las funciones de GUITAR RIG 4 a entradas de controlador, consulte la guía de 
inicio rápido y el manual de la aplicación.

Para usar el RIG KONTROL como un controlador MIDI estándar, deberá emplear el programa 
CONTROLLER EDITOR que viene incluido con el producto. Consulte el manual de Controller 
Editor para más detalles.

6.1 Activación del RIG KONTROL en GUITAR RIG 4

El RIG KONTROL se activa de manera automática dentro de GUITAR RIG 4 cuando se co-
necta el aparato. Al activarse por primera vez, aparecerá una ventana que le pedirá calibrar el 
pedal. Presione por favor el pedal hasta el fondo y confirme con ok . El pedal puede volverse 
a calibrar en cualquier momento: vaya hasta la página de opciones (Options) y seleccione 
Preferences. Haga clic en el botón Reset junto a la opción “Rig Kontrol Pedal Calibration”.

GUITAR RIG 4 presenta también una representación gráfica del RIG KONTROL, la cual apa-
rece al cliquear el botón Virtual Kontrol encima del rack.

Si está manejando varias instancias de GUITAR RIG 4 (p. ej., en un secuenciador), deberá 
definir cuál de todas ellas será la controlada por el pedal. Por defecto, el RIG KONTROL se 
habilita para la primera instancia activada de GUITAR RIG 4 . Al cliquear el botón Connect 
de Virtual Kontrol de otra instancia, el RIG KONTROL pasará a esa instancia: el aparato solo 
puede habilitarse para una instancia por vez.

Algunas funciones están asignadas, por defecto, a los interruptores de pie 5-8 (como aparece 
señalado por los rótulos respectivos en el hardware). Con los interruptores 5 (anterior) y 6 
(siguiente) podrá recorrer los presetes que están visibles en el buscador. Los interruptores 7 
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y 8 activan la afinación (tuner) y la estimación del tempo con el pie(Tap). Por supuesto, estos 
controles pueden también reasignarse a otras funciones.

La manera más fácil para asignar el pedal o un botón del RIG KONTROL a cualquiera de las 
funciones del rack es arrastrar el pedal o el botón desde el gráfico de Virtual Kontrol hasta 
la función que se desea asignar. Para una descripción detallada del funcionamiento de las 
asignaciones, consulte por favor la guía de inicio rápido y el manual de la aplicación.

6.2 Empleo de controladores MIDI con la interfaz MIDI RIG KONTROL

Mientras que el RIG KONTROL se comunica con el programa GUITAR RIG 4 directamente a 
través de la conexión USB, también es capaz de enviar mensajes MIDI para controlar otras 
aplicaciones externas. Sin embargo, también cuenta con una interfaz MIDI provista de un 
canal de entrada y otro de salida.

Para usar un controlador conectado a la entrada MIDI, asegúrese de que el canal MIDI del 
RIG KONTROL esté activado en GUITAR RIG 4.

1. Abra la ficha “Audio and MIDI Settings”. En Windows, se encuentra dentro del menú de 
archivos (File) del programa y en Mac OS X, en el menú Guitar Rig 4.

2. Abra la ficha “MIDI”

3. En Inputs, localice la entrada RIG KONTROL actívela haciendo clic en la columna Status.

El canal de entrada MIDI se configura en el panel de opciones (Options) de GUITAR RIG 4: en 
la ficha Preferences, haga clic en el menú desplegable de “MIDI channel” y seleccione 1-16 
o omni. Para saber la manera de asignar funciones a controladores MIDI externos, consulte 
la guía de inicio rápido o el manual de la aplicación.
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6.3 Empleo de pedales e interruptores de pie adicionales

El RIG KONTROL presenta dos enchufes que sirven para conectar pedales e interruptores 
de pie externo mediante cables de un ¼”. Una vez conectados y configurados, podrán ser 
asignados como controladores MIDI en GUITAR RIG 4. Consulte la guía de inicio rápido o el 
manual de la aplicación para más información.

En Options > Preferences, GUITAR RIG 4 presenta las siguientes opciones:

 • Para calibrar un pedal externo, haga clic en el botón Reset junto a “Rig Kontrol Ext Pedals 
Calibration”.

 • La opción Rig Kontrol Ext Pedal 1/2 Mode permite configurar cada una de las entradas para 
que coincidan con el pedal o interruptor de pie externo. Consulte la especificaciones del 
fabricante para averiguar si el pedal es “tip” o “ring” o si el interruptor de pie es un control 
de apertura o cierre. Si surgieran problemas, pruebe entonces los otros modos disponibles.
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7 Solución de problemas
Si se encontrara con algún problema en el funcionamiento de su unidad, antes de ponerse en 
contacto con nuestra asistencia técnica, le recomendamos seguir los pasos siguientes para 
encontrar una posible solución.

 • Visite el banco de conocimientos de NI. Puede acceder al mismo rápidamente desde el 
menú de GUITAR RIG 4, seleccione Help > Knowledgebase.

 • Visite el Foro de usuarios de NI (en (http://www.native-instruments.com/forum/) y busque 
respuestas y consejos útiles brindados por la comunidad de usuarios de GUITAR RIG.

Al ponerse en contacto con el equipo de asistencia técnica de Native Instruments, asegúrese 
de tener a mano toda la información relevante. Para saber la versión del controlador y del 
firmware, consulte el panel de control del controlador.

 • En ordenadores con Windows, encontrará la versión del controlador y del firmware en el 
menú de “Inicio” en la carpeta de programa de GUITAR RIG 4. Haga clic en la opción 
“About” y aparecerá la información correspondiente. 

 • En ordenadores con Mac OS X, puede acceder al panel de control del controlador desde 
el sistema de preferencias. 

Visite por favor esta dirección URL para ponerse en contacto con nuestro equipo de asistencia 
técnica:

http://www.native-instruments.com/support/

Todos los productos de NATIVE INSTRUMENTS han sido probados reiteradamente en situacio-
nes reales durante su fase de desarrollo. Sin embargo, si el producto necesitara ser devuelto, 
el equipo de soporte técnico le dará un número de RA (Return Authorization) para tramitar el 
procedimiento. Contáctese con nuestro equipo de asistencia técnica antes de efectuar cual-
quier tipo de devolución. Los paquetes que sean devueltos sin este número de RA no podrán 
ser correctamente identificados y no podrían ser procesados de manera eficiente. 

http://www.native-instruments.com/support/
http://www.native-instruments.com/support/
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7.1 Problemas relacionados con el audio

Este apartado brinda información para los problemas de audio más habituales que pudieran 
suceder.

7.1.1 No hay sonido o suena poco volumen
Hay varias razones posibles por la cuales no se produce sonido o el mismo sale con poco 
volumen:

 • Cables rotos o desconectados. Revise todos los cables y conexiones.

 • Se ha seleccionado una tarjeta de sonido o una entrada de audio incorrecta. Revise por 
favor la ficha Audio and MIDI Settings del menú de GUITAR RIG 4 para ver si el controlador 
del RIG KONTROL se encuentra seleccionado.

 • Se ha seleccionado el canal equivocado en el módulo de entrada de GUITAR RIG 4. Conecte 
su instrumento en la otra entrada o seleccione “L” para cambiar de canal.

 • La ganancia de entrada del RIG KONTROL está muy baja. Suba la perilla hasta el nivel 
deseado.

 • La perilla de volumen de su instrumento está bajada. Suba la perilla de volumen.

7.1.2 Señal distorsionada
Si la señal de audio suena distorsionada y, sin embargo, GUITAR RIG 4 no está añadiendo 
ningún tipo de distorsión, lo más probable es que la ganancia del RIG KONTROL esté muy 
alta. Reduzca el nivel de entrada de la interfaz para evitar que el preamplificador cause dis-
torsión. Si su instrumento produce una señal tan alta como para que el preamplificador esté 
siempre saturado, reduzca entonces su volumen. Normalmente, esto sólo sucede cuando el 
instrumento viene equipado con una electrónica especial, como por ejemplo pastillas de alta 
salida.
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7.1.3 Ruido
Cuando se percibe zumbido, las razones que lo causan pueden ser variadas:

 • Las pastillas de bobinado simple son propensas a recoger las interferencias eléctricas. Las 
pastillas Humbucker producen mucho menos ruido.

 • Su guitarra está muy cerca del equipo eléctrico. Para reducir este tipo de zumbido, despla-
ce la guitarra más lejos del equipo.

 • La perilla de volumen de la guitarra está puesta muy bajo. Suba la perilla. Si la guitarra 
cuenta con más de una perilla de volumen, verifique el volumen de todas la perillas.

 • Está empleando un cable roto o que no está debidamente protegido. La pantalla de la gui-
tarra podría no ser suficiente. Primero trate de reemplazar el cable por un modelo con 
pantalla protectora. Si esto no funciona, un profesional debería revisar la electrónica de su 
guitarra y dotarla de una protección mejor.

Si percibe siseo, el volumen de entrada del preamplificador del RIG KONTROL puede estar 
demasiado bajo. Suba el volumen del instrumento o incremente el nivel de entrada del RIG 
KONTROL. Para más información sobre el ajuste del nivel de entrada, consulte la sección 
4.4 (Windows XP/Vista) o la sección 5.4 (Mac OS X) de este manual.

7.1.4 Bucles de masa
Los bucles de masa (generalmente percibidos como un zumbido de baja intensidad) son un 
problema frecuente que se produce cuando varios dispositivos eléctricos forma parte del 
mismo circuito eléctrico. Los siguientes pasos lo ayudarán a eliminarlos:

 • Desconecte todos los dispositivos que no esté usando, p. ej., dispositivos periféricos conec-
tados al ordenador (discos externos, grabadoras de CD, etc.).

 • Conecte una caja DI detrás de las salidas del RIG KONTROL. La mayoría de estas cajas 
tienen un interruptor que se usa para romper el bucle y eliminar de esta forma el ruido.
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7.2 Problemas relacionados con el hardware

Verifique la disponibilidad de actualizaciones y otras informaciones relativas al RIG KONTROL 
en el sitio de Internet de Native Instruments y en el NI Service Center.

7.2.1 Problemas relativos al controlador
Asegúrese de que el RIG KONTROL esté conectado al ordenador y abra el panel de control. 
La ubicación del mismo ya la hemos señalado en la introducción de este capítulo 

Si el panel de control no se encontrara, es probable que el controlador no se haya podido 
instalar. En este caso, vuelva a instalar el controlador de la manera descrita más arriba en 
este manual.

Si todos los menús desplegables del panel de control aparecen de color gris, significa que el 
RIG KONTROL no ha sido reconocido por el controlador. Es posible que algo no ande bien 
con la conexión USB, la sección siguiente le brindará más detalles al respecto.

7.2.2 Problemas relativos a la conexión USB
RIG KONTROL es una interfaz USB 2.0 y no funcionará en puertos USB 1.0 o 1.1 . Lo mejor 
es conectar el aparato directamente en un puerto USB 2.0 del ordenador. Además, el puer-
to necesita cumplir los requisitos mínimos de alimentación eléctrica de un puerto USB 2.0 
(500 mA). Algunos ordenadores no satisfacen el estándar oficial de alimentación eléctrica 
para puertos USB 2.0 . En este caso, es posible que un mensaje aparezca indicando que no 
hay suficiente energía disponible para operar el dispositivo. RIG KONTROL podría entonces 
producir crepitaciones o directamente no funcionar.

 • Si su ordenador no puede suministrar suficiente energía, haga la prueba de conectar su 
RIG KONTROL en un hub USB 2.0 con fuente de alimentación propia. En este caso, debe-
ría evitar la conexión de otros dispositivos al hub, dado que éstos disminuirían la potencia 
total disponible.

 • En caso de fallas, resulta útil comprobar si RIG KONTROL funciona mejor al desconectar 
los otros dispositivos USB del ordenador.
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 • Si experimenta fallas en el audio o algún otro tipo de problema relacionado con la co-
nexión USB, conecte el RIG KONTROL en otro puerto USB 2.0 del ordenador.

 • Un cable USB en mal estado puede ser responsable de las caídas en el audio y de otros 
problemas de conectividad. Pruebe con un cable diferente (con el logo oficial USB); en 
algunos casos también resulta beneficioso emplear un cable más corto.

 • Si RIG KONTROL experimenta problemas de mal desempeño en una máquina Windows, 
lo primero que debería hacer es deshabilitar el control de alimentación de los hub USB, que 
siempre se encuentra activado por defecto. Vaya al administrador de dispositivos (Panel de 
control > Sistema > Hardware) y haga clic con el botón secundario en un hub USB para 
abrir sus propiedades. En la página de control de alimentación desmarque todas las casillas. 
Repita esto para cada hub y luego reinicie el sistema.

7.2.3 Empleo del RIG KONTROL con un ordenador portátil
Primero debería verificar que el ordenador sea apto para manejar el procesamiento de audio 
en tiempo real sin experimentar fallas. En la red encontrará un par de herramientas gratuitas 
que le servirán para analizar la capacidad de su sistema, por ejemplo:

www.thesycon.de/deu/latency_check.shtml

Inicie esta herramienta con el RIG KONTROL desconectado. En caso de que su ordenador 
no pueda procesar audio sin experimentar problemas, la herramienta le mostrará barras rojas 
de latencia y reportará esto en la caja situada abajo de todo.

En general no se recomienda el empleo de ordenadores portátiles con tarjetas de memoria 
gráfica compartida. Seguramente va a necesitar toda la memoria y capacidad de procesa-
miento disponibles para sus proyectos de audio.

Aquí le presentamos algunos consejos para optimizar el desempeño de su portátil:

 • No se recomienda usar el ordenador con las baterías porque el administrador de energía 
podría hacer atrasar el reloj del CPU para ahorrar consumo.

 • Desconecte todo los aparatos que no vaya a usar (p. ej., impresoras y escáneres). Esto ali-
viará el trabajo del ordenador y aumentará la capacidad de procesamiento disponible para 
el programa musical.

www.thesycon.de/deu/latency_check.shtml 
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 • Los ordenadores portátiles están equipados con dispositivos integrados que pueden per-
turbar el procesamiento de audio, entre los más comunes se cuentan los adaptadores de 
red y la tarjetas inalámbricas LAN. Es posible que tenga que desconectar estos dispositivos 
cuando quiera trabajar con el RIG KONTROL. 
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8 Especificaciones técnicas
Esta sección contiene todas las especificaciones técnicas relevantes del dispositivo RIG 
KONTROL.

8.1 Enchufes

 • 2 enchufes de entrada (In 1, In 2) para clavijas mono de 6,3 mm (1/4 pulgada).

 • 2 enchufes de salida (Out 1, Out 2) para clavijas mono (no balanceado) de 6,3 mm (1/4 de 
pulgada) o conectores TRS (balanceado).

 • 1 enchufe estéreo de auriculares para clavijas de 6,3 mm (1/4 pulgada).

 • 2 entradas para enchufes de pedales externos/ interruptores de pie/cajas interruptoras.

 • (Pedal 1, Pedal 2) para clavijas estéreo de 6,3 mm (1/4 pulgada).

 • 2 conectores circulares MIDI (In/Out) de 5 patillas.

 • 1 USB 2.0 Tipo B.

8.2 Especificaciones de audio

Entradas de audio (A/D)

Canales 2

Frecuencia de muestreo 44,1; 48; 88,2; 96 y 192 kHz

Definición en bits 16 y 24 bits

Convertidor Cirrus Logic
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Entradas de instrumento

Impedancia de entrada 1 MΩ

Nivel máximo con ganancia máxima -11,5 dBu

Nivel máximo de entrada +16 dBu

SNR (ponderado) >100 dB

THD+N 0,009%

Respuesta de frecuencia +/- 0,5 dB 20 Hz – 24 KHz 

Rango dinámico 105 dB (ADC)

Entradas de línea

Impedancia de entrada 44 kΩ

Nivel máximo con ganancia máxima -5,5 dBu

Nivel máximo de entrada +16 dBu

SNR (ponderado) >100 dB

THD+N 0,009%

Respuesta de frecuencia +/- 0.5 dB 20 Hz – 36 kHz 

Rango dinámico 105 dB (ADC)
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Salidas de audio (D/A)

Canales 2

Frecuencia de muestreo 44,1; 48; 88,2; 96 y 192 kHz

Definición en bits 16 y 24 bits

Convertidor Cirrus Logic

Salidas de línea

Impedancia de salida 100 ohmios

Nivel máximo de salida +6,3 dBu

SNR (ponderado) >100 dB

THD+N 0,010%

Respuesta de frecuencia +/- 0,5 dB 20 Hz – 36 KHz 

Interruptor de nivel alto/bajo Máximo 5 Vpp / -14 dB 
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Salida de auriculares

Impedancia de carga 8-600 Ohmios

Nivel máximo de salida 1,61 V RMS @ 100 ohmios

SNR (ponderado) > 91 dB

THD+N (60 ohmios) 0,013%

Respuesta de frecuencia +/- 0,5 dB 22 Hz – 44 kHz

8.3 Suministro de energía

Vía interfaz USB 2.0, bus de 5 V - 500 mA 

No se necesita ninguna otra fuente de energía o batería, solamente es requerida la energía 
del USB. Sin embargo, el funcionamiento adecuado sólo se garantiza cuando RIG KONTROL 
está empleado como único dispositivo individual de un controlador USB 2 o con un hub USB 
2 con fuente de alimentación propia.

8.4 Dimensiones y peso

Dimensiones: 360 x 237 x 102 mm (14.1 x 9.3 x 4 pulgadas)

Peso: 2,6 kg (5,73 lb)
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8.5 Especificaciones ambientales

Temperatura de funcionamiento: de 0°C a 40°C (32°F s 104°F), (85% de humedad no con-
densada) 

Temperatura de almacenamiento: entre -20°C y 50°C (-4°F a 122°F), (85% de humedad no 
condensada)

8.6 Requisitos de sistema

8.6.1 Especificaciones generales del sistema
Windows XP Service Pack 2 o Windows Vista (32/64 bit), procesador Intel® Pentium™ o 
AMD® Athlon™ XP de 1,4 GHz, 1024 MB de RAM y USB 2.0

Mac OS 10.5, Intel® Core™ Duo 1.66 GHz, 1024 MB RAM, USB 2.0

8.6.2 Formatos de controlador soportados
Mac OS: Core Audio™

Windows: ASIO® (recomendado), DirectSound™, WASAPI™

8.6.3 Plataformas aceptadas
Mac OS: standalone, VST®, Audio Units™ y RTAS® (Pro Tools 7/8)

Windows: standalone, VST® y RTAS® (Pro Tools 7/8)
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